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Introduction 
 

This manual is about the indoor technology transfer（”Aerial triangulation”, “Digital plotting”, “Digital 
compilation”, “Map symbolization”, “Digital data structurization” ）in this project. In consideration of technical 
levels of the DGC members who attended the indoor technology transfer, this manual was prepared with 
emphasises on following main points. 

 
・ A basic operation for those who use the softwere for the first time 
・ An operation about basic work at each stage of map making in this research 
・ It plays a role as a guideline for searching an official manuals of each softwewre（Due to its tremendous 

amount of information, the official manual is not suitable for inexperienced users to look up some basic 
operations） 

・ Visualizing each settings and inputting procesure by capturing screen image 
 
This manual was prepared within an exercise of each indoor technical transfer. Some extra components are added 

into the manuals when everybody gets stuck on certain points during the exrcise. 
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Aerial Triangulation  
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Chapter 1  Aerial Triangulation 
 

Open LPS( ERDAS Imagine ) 

 

1-1 Aerial Triangulation for Aerial photos 
 

1-1-1 Work Flow of Aerial Triangulation for Aerial photos 

Block Setting 

Import Images  Import EO or GPS/IMU 

Camera Setting  

Interior Orientation 
(Analog Camera) 

GCP Observation  

Tie Points Observation  

Block Adjustment  

 

Figure 1 Basic Work Flow of Aerial Triangulation 
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1-1-2 Block Setting 

 

(1)  Open New Block 

Open LPS 

 
 

Create New Block ( Project) 

 

 

Input Block name ( EX: “togo-at-tr2”) 
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(2)  Select Camera Type (See 1-4 for “Camera Setting”) 

Select “Frame Camera” for “analogue camera”. 

 
 

Select Horizontal Coordinate System after clicking “Set” in “Standard” tag, then select “UTM WGS 84 

North” as “Categories” and select “UTM Zone 31” as “Projection” 

  
 

Select Vertical Coordinate System (Spheroid: WGS84, Datum: EGM2000) , then “OK” 
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Click “Next” and Input Flight Height as 5,000m then “OK”. 

 
 

 

1-1-3 Import Images 

Click “Add frame” and move into the work Folder and after choosing “Files type”, select images. 

 

 

 

 

 

 

 1-4 



The Study on Establishing Topographic Database in Togo 
Technology Transfer Manuel 

 

1-1-4 Interior Orientation 

(1) Camera Setting  

Go to Interior Orientation 

 

 

Create Camera file 

 

  

Input “Name”, “Focal length”, “Principal Point(x,y)” from Camera calibration file 

in “General” tag. 
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Input “Fiducial Coordinates”in “Fiducials” tag  (In case of Frame Camera). 

 
 

Input “Distortions” (In case of Frame Camera). And “OK” 

Push this buttons 

to add a line. 
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(2)  Interior Orientation  

Go to “Interior Orientation” tag and set the direction of all images.  

 

 

 

Open Interior Orientation Viewer on the first image. 

 

 

 

Label Label

①② 

③ ④ ① ② 

④ ③ 
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Open Interior Orientation Viewer.  

① Move cursor on the 

Fiducial 1. 

 

②Click Observation Button. 

③Click on the 

center of 

Fiducial 1. 

④ continue from Fiducial 2 to 4.  

After the observation of all 4 points, If the result clear the tolerance(0.03mm), go next. 

(In this case, 7.3 microns is less than 0.03mm=30 microns) 
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Continue Observation of fiducials for all remaining images. In case of automatic “Interior Orientation”, 

one image must be observed and the direction of images must be checked.  

 

 

After, “Automatic Interior Orientation”, click “Accept”.  
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1-1-5 GCP Observation and Tie points Observation 

Go to Points measurement tool 

 
 

Select “Stereo” (Stereo-view work) or “Classic” (Mono (Split)-view work). 

 

 

Click “Add” to input new GCP 
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Input “Point ID” with number, “Description” with character, Type as “Full”, X, Y, Z coordinate of GCP. 

Then continue input of all points. 

 
 

If a text file of “GCP” exists as below, import the file by” Import points” icon.   

 

 

 

Then all GCP shall be observed manually. In case a GCP locates on 6 images, 6 images must be 

observed.  
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<GCP1> 

 

X: 291322.0, Y: 840240.0, Z: 299.0 
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<GCP2> 

 

X: 297057.0, Y: 839879.0, Z: 250.0 
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<GCP3> 

 

X: 289987.0, Y: 830571.0, Z: 226.0 
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<GCP4> 

 

X: 294212.0, Y: 830077.0, Z: 300.0 
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<GCP5> 

 

X: 293466.0, Y: 835135.0, Z: 380.0 
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1-1-6 Tie points Observation 

(1) Manual Tie points measurement 

Add tie points (Type: None, Usage: Tie) and measure on image one by one same as GCP. 

 

 

(2)  Automatic Tie points measurement 

Click “Automatic tie properties” and go to “Distribution” tag, then click “View Graphic””. 
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Set allocation of tie points visually, then “RUN” or click  icon. 

 
 

Check result and “Close” then added tie points can be seen in the point measurement window.  
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 1-19

 

1-1-7 Block Adjustment 

Go to “Triangulation Properties”. 

 

 

Set Adjustment Parameter in “General” tag and “Point” tag. Tolerance depends on “Flight height”, 

“Image resolution” etc. Then click “Run” or click.  icon. 

 
 

 

 

Check Result 

 

Click here to know the 

detail. 
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Exterior Orientation 

Result. 

RMSError of GCP. 
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1-2 Aerial triangulation for ALOS Satellite Images  
 

1-2-1. Create Project (Block File) for Satellite 

 

 

 

 

Newly Input a filename. 

 

Set “Horizontal Coordinate System” Ellipsoid as “WGS84”, Projection as “UTM Zone 31N” 
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Set “Vertical Coordinate System” EGM 2008. 

 

 

 

 

Input Average Elevation 
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1-2-2. Import Image files 

Click “Image import button” and “set file type” as “ALOS PRISM JAXA CEOS (VOL-ALPSM*)” 

 

 

 

 

 

 

 

 

 

Choose file until all necessary images are imported. 
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1-2-3. GCP Observation 

Click “Point Measurement Tool” and Choose Classic one. 

 

Add a GCP by “Add ”Button. 

 
 

 
 Pt number Pt Name Set “Full” Set “Control”

 

Then Input “X”, “Y”, “Z” of GCP 
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<GCP1: x, y, z = 289293m, 982816m, 390m > 

”, “Description” →  “Type”, “Usage” → input coordinates → 

 

 

Add point and input “ID

Observe point 
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<GCP2: x, y, z = 310173m, 978691m, 330m > 
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<GCP3: x, y, z = 295197m, 1011640m, 410m > 
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<GCP4: x, y, z = 321203m, 1006362m, 345m > 
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1-2-4. Tie Points Measurement (Automatic) 

Click “Automatic tie Properties” for setting strategy. 

 

Set preferable layout of “Tiepoints” by View Graphic then “OK”. 

 
 

 

 

 

 

 

Click “Automatic tie Process” and after processing, check result. 
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1-2-5. Adjustment (Calculation) 

Click “Triangulation properties” button for setting parameters. 

 

 

 

 

 

Click “Perform Triangulation” button for RUN “AT”. 

If the error is not acceptable, click “Report” to check wrong points. 

Re-measure the point and continue until the error becomes acceptable then “Accept”. 
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Save and Close 

 

 

Bigger error is showed by longer line( Blue one). 
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Chapter 2  DTM and Orthophoto Creation 
 

2-1 DTM and Orthophoto Creation 

 

Figure 2 Basic Work Flow of DEM and Orthophoto Creation 

 

2-2 DTM Setting 
Active images which are necessary for this work then click “DTM Extraction”.  

DTM Setting 

DTM Creation  Contour line 

Ortho rectification  

Ortho Setting 

Ortho Mosaic  

 

 

Choose “Classic ATE”. 
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Select type (DEM, TIN, Shape, ASCII) then set folder and file name for output.  

so input Cell size (DEM interval) of output. 

Properties” 

Al

After above setting, Click “Advanced 

 

<Go “General” Tag> 

Check the “Coordinate System” and Set Area of “DEM”by Upper Left XY ,Lower Right XY. 

If you need “Contour line” at a same time, Check “Create Contour Map”( a contour line shape 

file over the same area as DEM will be created automatically ).   

 

 

 

Area 

Of 

DEM 

UL X 

UL Y 

LR Y 

LR X 
 

<Go “Image Pair” Tag> 

Check Image pairs which are used for DEM creation. Then “OK”. 
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2-3 DTM Creation 
< “RUN” DTM Extraction> 

When the “RUN” icon is clicked, the process is start and the calculation needs time (depends 

on the “Area”, “Image volume”, “Cell Size”, etc). 

 

 

After Extraction of DEM, The created DEM appears.  
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The created DEM can be seen also in “ERDAS Imagine”. 

ew #1” then select “Open Raster Layer” and choose the DEM files. Right click on “2D Vi

 

 

 

About seeing “Contour line”, ”Open Vector Layer”

 

 

 

 

 

 

 

 in above window. 
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Chapter 3  Orthophoto Creation 
 

3-1 Ortho Rectification 
In this work, Each images shall be ortho rectified one image by one image. 

Choose an image which are necessary for this work then click “Ortho Resampling Process”.  

 

 

Set folder and file name for output.  

Choose DTM format and DTM file 

Input “Output Cell size”(GSD of Ortho Image) and area by Upper Left XY ,Lower Right XY.  

Then go “Advanced” Tag and set “Overlap threshhold” if necessary. 

After above setting, Then “OK”. 
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After the processing (ortho image creation is 100% finished), “close” the window.   

 

 

Continue the same process on the other images necessary. 

 

 

Check the result (in LPS or ERDAS Imagine). 
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3-2 Ortho Mosaic 
Click “Start Ortho Misaicking process” 

 

 

Choose “block file” in “MosaicPro” window and check “Use Entire (all) image” in “Image 

Area Options” tag. Then “OK” 
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Choose “Seamline” (Mosaic line; boundary between images ) method.  

 

 

 

Click “Set output Option”. Set area and Cell size if necessary.  

 

 

 

 

 

 

 

Created Seamline 

Auto Manually 
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 1-40

Click “Run the Mosaic Process” then choose folder and name for output image and “OK”. 

If the process is finished, “close” window. 

 

 

 

 

After finishing the Mosaic, check result (mosaicked image) in the “ERDAS Imagine”. 

 

 

Period 



 

 

 

 

 

Digital Plotting 
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Chapter 2-1  Digital Plotting Software Manipulation 
 

1-1 Microstation Basic Manipulation 

File Preparation  

 

Figure 1 Basic Work Flow of Digital Plotting 

 

1-1-1. Seed file setting (Scale, Grid, etc) 

Open Microstation V8i, and File -> New 

 
 

 

 

 

 

 

 

Open Pro600  

Digital Plotting  

Open LPS  

dgn file Template for 
the project Seed (.dgn) File 

Symbol setting file 
for points 

Symbol setting file 
for lines 

Cell (.cel) File 

Resource (.rsc) File 
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Choose work directory and input file name, then “OK”. 

 
 

Setting -> Design file 

Select “Working Unit” and set as follow, then “Edit” 

・ Format : MU 
・ Master Units : Meters 
・ Sub Units : Millimeters 
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Set Resolution then “Save Setting” From File. 

 

 

Save DGN File. 
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1-1-2. Cell File Setting (setting file for "symbols" defined in the "SYMBOLIZATION SPECIFICATION". ) 

Open MicroStation V8i 

 
 

File/new 

 

 

Choose work directory and input name of “New Cel file” 
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< Exercise ( 3002 Building)> 

(1)  Open Level Manager 

 

 

(2)  Create New level 

 

 

(3)  Set “layer 3002”as Active 
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(4)  Draw Shape 

① Place Smartline 

② Toggle Accudraw 

③ Input 1(mm) as “Y” Direction 

④ Input 1(mm) as “X” Direction 

⑤ Input 1(mm) as “X” Direction 

⑥ Snap to start point 

 

 

 

(5)  Hatch inside the Drawn Shape 

 Select “Hatch area” and Set “Spacing “as 0.1 then click on the target. 

 And click window (to decide). 

 

 

 2-1-6



The Study on Establishment of  Topographic Database in Togo 
Technology Transfer Manuel 

 

(6)  Set Origin (Origin Point) 

① Snap setting “shift” 

② Draw a “Diagonal line” 

③ insert point (Midpoint of the “Diagonal line”) 

 

 
 

 

 

(7)  Registration 

 Element -> Cells, then Select Directory and input name. 
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Place fence to include the shape and click “Create”. Then Input Name as 3002. 

 
 

 

 

1-1-3. RSC (Resource) File Setting (setting file for "line type(color, style, weight)" defined in the 

"SYMBOLIZATION SPECIFICATION". ) 

Open MicroStation V8i 

 
 

File -> new, then Choose work directory and input name of “New RSC file” 
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Element -> Line Styles -> Edit, then select the created file. 

 

 

 

 

 

Edit -> Crate -> Stroke Pattern 
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< Exercise 1 ( 1001 Boundary between countries)> 

(1)  Open “Line Style Editor”, then Edit -> Crate -> Name Open Level Manager 

 
 

(2) Input newly “Style Code” as 1001 and Select ”Stroke” as Line Type. 
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(3) Create Pattern 

① 1 st Dash ( Line: 2.0mm) 

② 1 st Gap ( Space: 0.6mm) 

③ 2 nd Dash (Line: 0.3mm) 

④ 2 nd Gap (Line: 0.6mm) 

 

① Click “Add” , then Choose “String Type” as “Dash” and input 2.0 in “Length” 

 
 

② Click “Add” , then Choose “String Type” as “Gap” and input 0.6 in “Length” 
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③ Click “Add” , then Choose “String Type” as “Dash” and input 0.3 in “Length” 

 
 

④ Click “Add” , then Choose “String Type” as “Gap” and input 0.6 in “Length” 

 
 

Save RSC( Resource) file. 
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< Exercise 2 ( 4202 Planting fence)> 

(1)  Cerate Line Stroke_component: Input newly “Style Code” as “4202_str” and input”4202_str” as 

Component. 

(2)  Click “Add” , then Choose “String Type” as “Dash” and input 2.5 in “Length” 

 

 

(3)  Cerate Line Point_component: Draw “Nip-line” , with a length 2.0mm to Y direction. And put 

insert point on “midpoint”. 
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(4)  Edit -> Create ->Point, Then input name as “4202_poi” and Input “4202_poi” as Component.  

(5)  Click “Create” and click “OK” in “Create Point Symbol” window. 

 

 

(6)  Click “Base Stroke Pattern” and choose “4202_poi” as stroke. Then click “OK” in “Create Point 

Symbol” window. 
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(7)  Click “Base Stroke Pattern” and choose “4202_str” in “Base Stroke Pattern” window.  

 
 

(8)  Click “Select” Button and choose “4202_poi” in “Create Point Symbol” window. And Select “4202 

point-stroke pattern”. 
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(9)  Create Line component : Edit ->Create -> Stroke Pattern , then Select “4202_poi” as Name” 

and  input “4202_line” as component. 

(10)  “Add” , then Choose “String Type” as “Dash” and input 2.5 in “Length” 

 
 

(11) Edit -> Create -> Compound , Click “Insert” and Select “4202_poi” and “4202_line”. Then 

“OK” 
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(12) Input “4202” as Name and input “4202” as Component. Then  Edit ->link. After 

that, File -> Save. 

 
 

(13) File -> Import -> MicroStation Resource File (RSC), then Select Code name and 

click “Import”. 
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1-2 Microstation and LPS and Pro600  
 

1-2-1. LPS Setting 

 

(1)  Open LPS 2011 

 

(2)  File -> New, Input new file name 

 

 

 

 

(3)  Model Setup 

Geometric Model Category: Rational Functions 

Geometric Model IKONOS 
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(4)  Coordinate System Setup 

Click “Set” for Horizontal Setting and go to “Standard” tag. 

Select “UTM WGS 84 North” from “Categories” and Select Zone 31 as “Projection”. 

 

 

 

 

 

 

Click “Set” for Vertical Setting and go to “Standard” tag. 
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Select “WGS 84 North” from “Spheroid Name” and Select “World Wide 1-Minute Geoid Height 

{EGM2008} “as “Datum Name”. Then click “OK”. 
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(5)  Import Images 

Click “Import Frame” Button. 

 

 

Select “TIFF” format from “File of type”. 
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(6)  Image setting 

Click “Pry.”, Then Choose “All Images Without Pyramids” to create pyramid file. Then 

“OK” 

 

 

Click “Int.”, Then Select RPC file in “RPC Coefficients” corresponding to imported image 

in “IKONOS Frame Editor”. And set 500m in Mean elevation. 
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(7)  Save Block file 
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1-2-2. Stereo Plotting Function(Pro600 Setting) 

 

(1)  Click “Start Feature Collection Application” Button. 

 

 

 

(2)  Click “New” and go to work Directory, then input file name. And “OK”. 
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(3)  Go to “Design files” tag, and Click “Add/Remove File”. 

 

 

(4)  Choose “togo_standard.dgn”, then click “Done”. 
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(5)  Go to “Project files” tag, and Click “PRO600 Library”. And Choose 

“togo_pro600_library.rsc”. 

 

 

 

(6)  Click “Cell Library”, then Choose “togo_cell_library.cel”. 
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(7)  Click “DGN Seed File”, then Choose “Togo_DGN_seed_file”. 

 
 

(8)  Go to “Project parameters” tag, and input 50000 in Mapping scale. 
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(9)  Go to “Initial view” tag, and input 1000 in Scale. 

 

 

(10) Go to “Tolerance” tag, and input values as follow. 
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(11) Go to “Stream parameters” tag, and input values as follow. 

 
 

(12) Click “Save Project”, and click “Open DGN File”. 

 

 

 

 2-1-29



The Study on Establishment of  Topographic Database in Togo 
Technology Transfer Manuel 

 

1-2-3. Microstation Setting 

 

(1)  PRO600 -> Library -> New 

 

 

(2)  Input scale as 50000 in “Pro600 Library Manager” window. 
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(3)  Entry Line Code Library. 

 Click “Create” Button and input Line codes (Left: minimum code in consecutive code, Right 

maximum code in consecutive code) 

In case of 1001, 1002, 1003, 1004: Input min(1001) in left and input max(1004) in right 

 
 

Click “Edit” and input values as follow to define Lines, Then click “Next”. 
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(4)  Entry Cell Code Library. 

 Click “Create” Button and input Cell codes. 

 
 

Click “Edit” and input values as follow to define Symbol with 1.0 Scale. 
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1-2-4. Open work file for Digital Plotting 

 

(1)  Open LPS2011, File -> Open.. 

 

 
 

(2)  Go to D:/jica/PLOT/plot_TR1/projects. 
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(3)  Select “Jica_tr1.blk”, then OK 

 
 

(4)  Click “Start Feature Collection Application” Button. And Open 

“jica_Tr1_PRO600_projects.prj”. 
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 2-1-35

 

(5)  Select “teamA” or “teamB”select  Open DGN FILE. 

 
 

Period 
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Chapter 2-2  Digital Plotting Work Manual 
 

1-1 Work Flow of Digital Plotting 

Field Identification 

 

Figure 1 Basic Work Flow of Digital Plotting 

 

Digital Plotting 

Aerial Triangulation  

Railways 

Buildings  

Roads  

Field ID Result 

Images, AT result 

Water body 

Vegetation

Spot height

Contour line

Field Completion 

QC 
OK 

Map for F_Completion 
NG 

Digital completion

QC 

OK 
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1-2 Plotting method of each Feature  
 

(1) Road 

Basically, the order of plotting goes form major class to minor class. 

About the classification of road, result of Field Identification and existing map shall be referred. 

・ Trace paved roads (2001, 2002) -> Unpaved major roads, unpaved second road (2003, 2004) 

・ Track roads, Footpaths (2006, 2007) -> Roads under construction (2005) 

 

(2) Railroad and their Structures 

About the classification of functional / un functional railway, result of Field Identification shall be 

referred. 

・ Railway (2020, 2102) -> Structures (2201, 2202, 2203) 

 

(3) Buildings 

When public buildings are plotted, the result of Field Identification shall be referred for their attributes. 

・ Small Buildings (3002) -> Large Buildings (3001) 

・ Build up Area (3010) 

 

(4) Water Bodies 

About the classification of rivers, existing map shall be referred. 

・ Lakes, Ponds, Mares (5001, 5004) -> Structures for water body (5204, 5305) 

・ Rivers (5101, 5102, 5103) 

 

(5) Vegetation and their boundary 

About the classification of vegetations, height of trees, color and size on images, relation to water body 

shall be referred. 

 

(6) Spot heights 

Spot height (7302) must be put on the crossroad, somewhere higher then other, lower than other with an 

interval of 4cm on the map. 

 

(7) Contour lines 

Contour lines must be plotted to express the shape of ridge and river. 

 

Period 



 

 

 

 

 

Digital Compilation 
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Chapter 3 Digital Compilation Work Manual  
 

1-1. OUTLOOK OF GIS DATA PREPARATION BY BENTLEY MAP 

<CONTENTS > 

1-1-1. DATA EDITING 

1-1-2. POLYGON TOPOLOGY CREATION 

1-1-3. POLIGON CREATION 

1-1-4. CONTOUR RETOUCHING 

 

1-1-1 After the stereo plotting,, the data will be subjected to the preparation for GIS data which is called 

“DATA EDITING” works. 

Main procedure of the “DATA EDITING “ 

 

(1) Data separation which is separated from the stereo plotted data into LINE, POINT and 3D FEATURES. 

The data separation works might be used “Select by attributes” commands, “Save as” 

and “Layer manipulation”. 

“Save as” 

“Layer manipulation” 

 

 

 

 LINE data are for roads, rivers, limits, scaled buildings, etc. 

 POINT data are for houses and remarkable symbols which are schools, churches, markets and 

so on.  

 3D FEATURS data are for contours, control points and spot heights, etc. 
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(2) Converting the line data to 2D whose is 0m elevation. 

As for converting 0m might be used “AZ=0” key in commands, tentative click by mouse 

and Scale Z value 0.0000001. 

“AZ=0” key in commands 

Scale Z value 0.0000001. 

 

 
 

 

 

 

 The line data should be converted to 0m elevation attributes. 

 

(3) Connecting line 

For Connecting line might be used “Connect line network” commands or using ArcGIS 

Arc tool Box in “Dissolve. For the partial connecting might be used “Create Complex 

Chain” with check in  “Simple Geometry. 

“Connect line network” 

“Create Complex Chain” 

 

 

 When Bentley MAP is used, the operation must be done with one by one layer in 

order to avoid unexpected merging between layers. 

 Before connecting line, the “Shape” elements, “Complex chain” and “Complex Shape” 

should be dropped. 
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(4) Splitting at intersections 

By using “Segment Linear Elements” command could be split line at once. Before using 

this commands might be placed fence. 

“Segment Linear Elements” 

 

 The line data should be split at intersections. 

 

(5) Detecting the errors (Data cleaning) 

When detecting the errors might be used “Find Gap, “Find Dangle” commands. Before 

using this commands might be placed fence. 

“Find Gap” 

 

“Find Dangle” 

 
 The small gaps whose distance less than 0.2mm-0.3mm on the map could be fixed 

under “Repair all” mode. If using large number of the tolerance value under the 

“Repair all” mode would bring to be changed inappropriate elements shape. 

 When the tolerance value of errors detection should consider into the map scale. In 

case of large scale map should be entered small value. 

 When using the large tolerance value would be detected many number of the error. 

 When detecting the dangles might be flagged all line’s tips which are starting or 

ending of line. 
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(6) Retouching the errors (Data cleaning) 

After detecting the errors should be carried out retouching each error. For retouching 

works, might be used “Trim”, “Extend”, “Modify elements”, “Add, Remove vertex” or 

any other functions of modify commands. 

 

 As for the retouching errors might be required cartographical judgments and “eye 

checking” 

 The error which is judged to not require retouching with cartographical judgments 

might be called “correct error” or “OK error”. 

 For example of “The OK error”; when the Dangles errors are detected starting or 

ending of points which is case of river, road and so on. As for the Gap errors are 

found short segments which are shorter than the tolerance value. It should be 

connected with next line. 

 After retouching the errors should repeat works of “4” to “6” until it will not be 

detected the errors other than “the OK error”. 

 
 Without this Data cleaning works the line, polygon data for GIS could not be 

create. The Data cleaning works is so hard that it will make you feel too 

troublesome. However it could not be avoided to make GIS data. 
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1-1-2 After the Data cleaning, the data will be carried out preparation for GIS data which is 

called “POLIGON TOPOLOGY CREATION” works. 

 

Main procedure of the “POLYGON TOPOROGY CREATION” 

 

(1) Cell separation which is distinguished cells for using the Polygon topology. 

The Cell separation might be used “Level Display”, “Save as” and Layer manipulation. 

“Save as” 

“Layer manipulation” 

 

 

 

 

 After saving file for the Polygon making, the unnecessary Cells which are point 

features symbols are deleted. 

 In the Polygon making, the cells are called centroids 

 A polygon must have a centroid inside of itself that is called the Polygon Topology. 

 

(2) Validate topology 

“Validate Topology” might be placed Fence. After detecting the errors could save the 

results. Text size for the Validation results might be used in “Place Text” window. 

“Place Text” 

“Validate Topology” 

 

 3-5



The Study on Establishment of Topographic Database in Togo 
Technology Transfer Manuel 

 

 Text size for the detected errors might be visible size, which is depending on map 

scale, for example 30m-50m. 

 The results of Validation will show the texts and lines which are coming from edge of 

each uncorrected polygon topology entry. 

 

(3) After the Validate topology will carry out the retouching results of validation. 

As for the validation “Texts” which are meaning type of topology errors. By using image 

reference “Raster Manager” could identify appropriate vegetation, land cover for 

appropriate a certain area. 

“Raster Manager” 

 

 

 multA: There is nothing not much. 

 MultC: it will be many errors. There is two or more “centroid” in the area. 

 

 noA: When it marks line inside feature which the area is incomplete, it will have to 

enclose for the “centroid” 
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 noC: When there is not any “centroid” into the area. 

 

 unuB: It appears that the line of the boundaries of polygon is incomplete,  so that the 

polygon is not formed. 

 The following case often happens. 

 

 

 However, the line and centroid looks like to be completed apparently 
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 If the portion of a circle is zoom in….Being such as this….However, such an error will 

be detected from finished data cleaning data. 

 

 

 When the retouching the errors might be required to draw line or modify again. 

 When the retouching the errors might be referenced “Orthophoto image”  
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Outlook of data extraction from enhanced ALOS image 

Feature Appearance 
Improved and paved road are straight line and its edges are clear with uniform width. 

Road In case of inferior roads which are track and such like, it has mincing winding shape 
with unclear edge and straightens.  
River looks like black bold line.  
In case of savanna area, it is having besides trees or bush that looks like bold black 
line. River  
When the river got dry, the besides vegetation cannot be seen or it looks like spares 
dots or so on. 
Swamp area’s appearance is black and gray area, of which center is black outer and 
gradually becoming gray towards outer. The edge is naturally dissipating. Swamp 

When one feature is containing water or moister, its appearance looks like black from 
image. Perennial lake or pond have a certain clear edge other hand seasonal is 
unclear. In case of artificial reservoir, it has clear edge or surrounded track which is 
used for maintenance. 

Lake, ponds 

Fish pond or hatchery, salt bet looks like tiled uniform rectangles or polygons.  
Cultivation has patched mosaic texture such like half random pattern. Cultivation Swidden cultivation is having black patched mosaic texture after burnt. 

Bush or 
spars trees 

Difficult to be extracted, because trees height cannot be identify from the Orthophoto. 

Always black and covered with tree’s crown, the texture is like rough carpet, however it 
is difficult to distinguish from low tree and bush. Forest 

 Because trees height cannot be identified from the Orthophoto. 
Rice field appearance is as unified rectangle and if contained water it is black, when 
after harvesting or resting the field are showing gray color. 

Rice field In case of large field, it has track which is also called “course way” for maintaining the 
field and working. 

Dwelling areas which are town, village such like are white color or light gray because of 
the fact that the ground has not vegetation and that the area has been developed for 
building houses. Dwelling 

area Commonly these areas are rotating by road junction or along main road or community 
road which is daily used by dwelling people. 

Building It is too hard to identify each house, In case of large building or some of big facility 
which consist of many big building, it is possible to extract under fine image condition.  

 

(4) Repeat the Validate Topology 

After retouching the errors should repeat works of “3” until it will not be detected the 

errors. 

 In case of the Polygon topology error validation has not exception such like “OK” 

errors. 

 Without these Polygon topology validation works, polygon data for GIS could 
not be create. The Polygon topology validation works is so hard that it will make 
you feel too troublesome. However it could not be avoided to make GIS data. 
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1-1-3 After the Polygon topology creation, the data will be subjected to the preparation for GIS data, which 

is called “POLIGON CREATION” works. 

 

Main procedure of the “POLYGON TOPOROGY CREATION” 

 

(1) Make sure to validate topology then the data should save as for the Polygon creation. 

“Save as” ,“ Select By Attributes” commands 

“Select by attributes” 

“Save as”  

 

 After saving as for the polygon creation would be changed layering that is unified 

all line data with a certain layer for example “0_line”. 

 

(2) For example. Turn On 2 layers which are a “0_line” layer and a kind of centroid Layer 6003. “Place 

Fence”, “Create Shapes” commands 

“Place Fence” 

“Create Shapes” 
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 After creating shapes, number of created shapes are shown at the bottom 

information window. 

 The Polygon creation must show the line layer and target centroid layer. 

 When showing 2 or more centroid layers it would be created showing layers 

shape in active layer at the same time. 

 

1-1-4 After the stereo plotting,, the elevation of separated contour data will be subjected to 

checking and retouching for GIS data 

 

Main procedure of the “CONTOUR RETOUCHING” 

 

(1) Finding incorrect contour elevation. 

From “Window”, “Views” commands then select “2” another view window whose name 

is “2” with Iso-metric view. 

“Window”, “Views” commands then select “2” another view 

 
 

View “2” with Iso-metric view. 
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 These two views might arrange horizontal or vertical displacement. 

 View 2 should rotate view front from “View Rotation”. 

 After “View Rotation” coming to front view, incorrect elevation contours could be easily 

found. 

 

(2) Retouching to correct elevation 

By using “CIVTOOLS” from Utilities in “MDL Applications”. 

Incorrect one can be retouched to right one by “Set Element Elevation” 

From Utilities in “MDL Applications”. 

“MDL Applications” 

 
 Select incorrect contour in the “Front view” then location of incorrect contour can 

be recognize in the “Top view” window with zooming out or in. 

 Zoom in to the incorrect contour then select neighbor correct one which is 

continuing to in correct contour at starting or ending in order to verify correct 

elevation value. 

 Enter the correct value in the “Set Element Elevation” then click wrong contour. 

For example when the right value is 440.0m. 
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 Above-mentioned operation should be repeated until wrong contours would 

disappear in display. 
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1-2. LINE CONNECTING PROCEDURE 

 

Before splits at the line intersection should connect any lines in each layer. 

 

1-2-1 Line connecting procedure by ArcGIS and Level status setting back to the previous one. 

 

(1)Your “dgn” file “Save as” .dwg file. 

 

 

(2)Select “dwg” from pull-dawn 
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(3) Open ArcGIS, then add data which is saved “dwg” file 

 

 

(4) Select your “dwg” file. Then click add 
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(5) It will add your “dwg” file 

 

 

(6) Open dwg file in the table of contents then select Polyline layer 

 
 

(7) Click right bottom then proceed Export data 
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(8) Make sure to go your directory then give the mane to your SHP file and click “Yes”. 

 

 

(9) Now adding, new SHP file which was saved from your DWG with one color 

 
 

(10) Show arc Tool BOX from the menu bar. 
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(11) Arc Tool Box will come out. 

 
 

(12) Start Editing from editor tool bar, select your SHP file. Then click OK (If you lost “Toolbar” 

you could find any “Toolbar” from Menu bar / Customize / Toolbars/ Then select them.). 

 
 

In case of this selected “Editor” from “Start Editing” 
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(13) Then select target SHP file which is Export Output. (example) 

 

 

(14) Select Data Management Tools / Generalization / Dissolve then Open 
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(15) Dissolve window will open.( “Input Features”, “Output Features”, “Dissolve Fields” must 

input by yourself) 

 

 

(16) In the Dissolve window, you can select you SHP file which is exported from “dwg”. 

 

 

(17) Make sure to go your directory then give the mane to your SHP file.( As for SHP file naming 

cannot use; -, space, +, and so on. Under score”_” can use naming) 
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(18) Dissolve Filed should be “Layer”. Connect lines at once in same layer. Then click “OK” and 

“Close”. 

 
 

(19) Added dissolved SHP in your “Table of contents” 

 

 

(20) Click right bottom then proceed “Export to CAD” 
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(21) Click right bottom then proceed “Export to CAD” 

The “dwg” file versions are available many type, you can select appropriate one. 

This time, 2004 might be recommended, then click OK. 

 

 

(22) After exporting to CAD, it will appear completed window then click close. 
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(23) You can see Exported dissolved dwg file in your table of Contents. After that, exit ArcGIS. 

 

 

(24) Open the “exported dissolved dwg” by Micro station. 

You might be aware of the dwg file changed only one color. 
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(25) From menu bar / Setting / Level / Manager, then” Level manager window” will appear. 

 

 

Or click right button on “Level display window”, then “Level Manager”. 

 

(26) From menu bar in the Level Manager / pull-dawn / Import 

 

 

(27) Make sure to go your directory, then select “Original DGN file” 
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(28) Level / Filter Import window will appear, then Click “Select all” and then click “OK” 

 

 

(29) Your dissolved dwg file color will change as previous looking 

 

 

 
 

 3-25



The Study on Establishment of Topographic Database in Togo 
Technology Transfer Manuel 

 

(30) Then save as DGN file again. 

 
 

Note: Closed lines such as polygons will become “shape” elements under this method. 

They might be dropped and connected before data cleaning. 
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1-2-2 Line connecting procedure by Bentley MAP function 

 

(1) Make sure to show a layer in your current file. For example 2004. 

 

 

(2) Place “Fence” with dragging in your display 

 

 

(3) Click “Connect Line network” from Topology Cleanup 
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(4) Then Click left button, and then right button. 

 
 

After that, you can see the results of connected line numbers in the bottom left of Bentley MAP. 

 

(5) This operation will be repeated to each layers. At the connecting, it must not show 2 or more layers, it 

will bring to merge between two layers. 

Note: when the lines have elevation attribute such as contours, this method cannot be 

used ; Elevation value will be lost. Elevation value should be entered from “Element 

Information” window in “Geometry at Elevation” 
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1-2-3 Line connecting procedure by Bentley Microstation 
 

(1) Click Create complex chain from Group – Main task or Main – Main Task 

 
 

(2) Create Complex Chain window will appear then check in ” Simplify geometry” 

If without check in, the connected line will be complex chain elements. 

 
 

(3) Click each segment from start with in turn. 

You can connect each line segments or each smart line elements. 
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1-2-4 Another method of complex chain creation 
 

(1) Check in ” Simplify geometry” and change method to Automatic 

 

 

(2) Click “start segment” will be following the line. 

 

 

Note: The connected line can keep elevation attributes under this method. 
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CONTOUR RETOUCHING 1-3. 
 

After “Stereo plotting”, the contour data might have contained errors which are missed, jumped far away elevation 

attributes. 

 

1-3-1 Contour retouching procedure by MDL Application “CIVTOOLS” in Micro station 

 

(1) Open your contour line file. 

 

 

(2) From menu bar / Window / Views then from the Pull-dawn / select “2” or any numbers. 
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(3) New view window which is “2” or your selected number’s one will open. 

 

 

(4) Arrange both windows sizing such as vertical or horizontal position as you like. 

Then click “Fit view” in order to see all elements. Then “Save setting” or “Ctrl+F” 

 
 

(5) Click “the View 2” window in order to turn active, then click “View Rotation: Front view. 

You can easily understand strange shape contours which are having bad elevations then zoom in them 

part. 
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(6) Select a bad contour in your front window then click “Element Information” from menu bar then you can 

see the contours elevation in the “Element Information” window which is showing “-621010.5686 m” 

now. 

 
 

(7) Turn the View 1 “Top view” window, you can see place of the contour line in Top view. 
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(8) From menu bar select / Utilities / pull-dawn / MDL Applications then” MDL “window will appear. And 

then select “CIVTOOLS” in Available Applications window. After that close “MDL” window. 

MDL Applications are supplied by “Bentley website “or other website such as forum which are regarding 

CAD software whose are some of Free or Share soft. 
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1-3-2 How to retouch the bad elevation contours 

 

(1) Select bad a contour from “Front view window”, it will be selected “Top view window” as 
well. 

You can see the position of bad contour in your “Top view window” now. Then tentative 
click on a right contour line which is connecting with bad contour line in order to know the 
“correct elevation” 

In case of following Image, the correct elevation is 420.0000m, which can be see at the 
bottom information bar. 

 
 

(2) Click “Set Element Elevation” from “CIVTOOLS” menu bar. “Set Element Elevation” 
window will be activated then you enter the number of the correct “Elevation” such as 
420.00 give in previous procedure with “Tentative click”. Then click on selected bad 
contour, which will change into the correct elevation. 
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(3) Then click on selected bad contour will change to the correct elevation. After changing the 

corrct elevationn in” Front view”. 

 
 

(4) Operation “1 to 3” should be repeated until coming to an end. 
 

(5) After retouching the bad contours, you can connect each contour if necessary. 
It might be reference with the line connecting procedure. 

 

1-3-3 Other method to retouch the bad elevation contours. 
Note: this method cannot fix the intensity elevation errors which are likely 
-125261.235 and 7878945.435456 such as beyond the general nature. 

 

(1) Select incorrect contour which is between upper and lower in “Front view”, in this case 
429.2340m, it can know in “Element Information” 

 

 3-36



The Study on Establishment of Topographic Database in Togo 
Technology Transfer Manuel 

 

(2) Check correct elevation from connecting right contours. By using the “tentative click” on a 
right contour line which is 460m. 

 
 

(3  the correct elevation number such as 460m on “Element Information” in ) Then you enter
Geometry at Elevation window. 

 
 

(4 on “1 to 3” should be repeated until coming to an end. 

(5  retouching the bad contours, you can connect each contour if necessary. 

) Operati
 

) After
It might be reference with the line connecting procedure. 
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OUTLOOK OF GEOGRAPHIC COORDINATE SYSTEM 
TRANSFORMATION BY BENTLEY MAP 

1-4. 

 

1-4-1 Identify the Geo-Coordinate system in current works. 
 

(1) Open a certain file in which geo-coordinate system will be transformed. 

 
 

(2) Select “Geographic” from menu bar then Click “Open as Toolbox”. 
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(3) “Geographic” Tool box will appear. Select left button 

 

 

(4) Click left button “Select Geographic Coordinate System” 

 

 

(5) “Geographic Coordinate System window” window will come up. 

 

 

(6) Click “From library” 
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(7) Select current souse Coordination system from library. 

In case of TOGO, WGS84 UTM31 might be selected because it covers almost entire TOGO area. Then 

Click OK. 

 
 

(8) “Geographic Coordinate System window” window will show selected coordination system’s information. 

If you do not need the Geographic Coordinate System, it could be detach by click the most right icon. 

 

Now your current file is identified : WGS84 UTM31. 
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1-4-2 Identify the Geo-Coordinate system for transformation of current works. 
 

(1) Open “From Library” 

 
 

(2) Select target geo-coordinate system. For example, WGS84 UTM zone30 because western part of TOGO 

is covered by UTM 30. 
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(3) “Geographic Coordinate System Changed window” window will come up, then select button below. The 

current works will transform from UTM31 to 30 zone. 

If you don’t need to transform the current works select upper button. In this case the coordinate system is 

only assigned. 

 
 

(4) Now changed UTM zone is selected as Geographic Coordinate System. 

 
 

(5) Click the most left button, the detail of current Geographic Coordinate System can be seen.  

 

Now your current file was transformed to WGS84 UTM30 from UTM31 

 3-42



The Study on Establishment of Topographic Database in Togo 
Technology Transfer Manuel 

 

1-4-3 Create the New Geo-Coordinate system. 
 

(1) Select a Geographic Coordinate System from library for example “UTM84-31N” then right click “Copy” 

 
 

(2) Then ”Paste” into seed folder or own folder 
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(3) After pasting, the copied” Geographic Coordinate System” is pasted as Copy-EPSG:32631 WGS 84 / 

UTM zone 31N. 

 

 

(4) Select Copy-EPSG:32631 WGS 84 / UTM zone 31N from seed folder then right click “Edit Coordinate 

System Properties” 
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(5) “Edit Coordination System Properties” window will come up then you can modify the property of 

coordination. When modifying it, you should enter official authorized data into each window then click 

“OK” For example this time below window (this is not official) . It might be used Datum “Point 58”. 

 

 

Now the new Coordination System is registered in seed file then select new one after that click “OK” 
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(6) “Geographic Coordinate System Changed window” window will come up then select below button. The 

current works will transform UTM31 to TOGO TM. 

If you don’t need to transform the current works select upper button. In this case the coordinate system is 

only assigned. 

 
 

(7) The current works file will be transformed to TOGO TM which is created as new geo coordinate system. 

You can recognize the data have been changed in display. 

 
 

After transforming the geo coordinate system it must be checked whether the data 
transformation results are appropriate or incorrect. 

 

Period 
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